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HEMRHBX R,

SECRAERITSMBXNEETMTEN, BfF KA N SEMRS. SLA HERRM
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« THAE (ABEENR)
- THHMER (IHEE).

2. B S5EEK

OTRS:ITSMHERSOTRSHENRERE , FJNOTRSEEFHIRBESER.

3. ftX

HEZFELKOTRSELW A T —MAREKK , AFPFIALAREREBBHIIRREZ MK F o) @R

RGNESMHEMNMI, INECRERE. BE. EA. AMECAALBXI SO, 1] iET
http://bugs.otrs.org (http://bugs.otrs.org/)BUGIRIR R AIRRZBUGHRE , Bl U EHIEBRR =M
FAEANG , R T REREH LK,

ERpIst X ANE T OTRS:  ITSMEMEFAR , AL eOHRRE, BR]LAEFE TThttp://otrs.org
(http://otrs.org/)IINZXMEX,

1.1. OTRS.org

>K/ OTRS & &

Solutions Software Customers Partners Company Open Source Academy Resources

Get OTRS Contribute Community News Documentation Source Code Mailing Lists Community Blog OTRS User Forum

FOUNDING
Open Source NetworkedHelpDesk.org

N MEMBER .

More than 5,000 active OTRS Community members, experts and enthusiasts,
contribute to the OTRS open source project and software, driven by the same
motivation, to enhancement and expedite OTRS' distribution based on voluntary
contributions. Get involved, leverage OTRS' community tools and benefit from the
support and technical expertise of this worldwide community.

Established since: 2001 Downleads: 1,115,000

Members: 5,000+ Installations: 100.000

Community Forum: forums.otrs.org ke Software available in: 32 languages
Get OTRS Contribute
OTRS Help Desk, ITIL V3 compliant IT Service If you want to suggest or vote for a feature, report
Management (ITSM) solution OTRS ITSM and all a bug. intend or already have completed a
OTRS extensions are published under the Affero localization for the software or simply want to
General Public License (AGPL) and are free for explore the community using the OTRS User
download without causing any license fees. forum, this is the right place to do.
Get the software now! »» Get involved! »»

4. mREYIFR

B2 ROTRS::ITSMIZE THITBIMREETIER |, EiAOhttp://lists.otrs.org (http://lists.otrs.org/) :
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1.2. lists-otrs-org

% OTRS Real Services

Solutions Software Customers Partners Company Open Source Academy Resources

Get OTRS Contribute Community Mews Documentation Source Code Mailing Lists Community Blog OTR

Mailing Lists

Subscribe to a mailing list of your interest and remain up-to-date, post your
questions, or review the archives for past discussions. Please keep in mind that this
is a form of non-commercial community support that does not guarantee an answer
to every guestion and that is related to a specific topic and language.

Announcements Developers

This list broadcasts announcements about OTRS This list is used by developers to discuss topics
Help Desk, mL®vs compatible ITSM solution related to the development of new releases,
OTRS ITSM and OTRS extensions. enhancements and issues.

Subscribe to Mailing List s Subscribe to Mailing List »»

Browse the Mailing Lists Archive s Browse the Mailing Lists Archive »»

OTRS Help Desk Users OTRS ITSM Users

This list is used by OTRS Help Desk users to file This list is used by OTRS ITSM users to file
questions and discuss resolutions amongst each questions and discuss resolutions amongst each
other. other.

Subscribe to Mailing List ke Subscribe to Mailing List »

Browse the Mailing Lists Archive » Browse the Mailing Lists Archive »»
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% 2 = OTRS: ITSMEFWERS

OTRS AGROTRSKETFOTRSHIFTHEIER (FNOTRS:ITSM ) MFIEHFNREABRMEE , ANBEE
WhRS RHE. NMEERRAFRME , ORS AGHIE AR A B UKENER {41 RT 8&-OTRSHI
OTRS:ITSMERREEML , FANR 2RI SOTRSMABXIIEWARS.

YEREBBNEIEIKEE , BRATAEWOTRSINE R, EWMAEEMRBEMERIRERESE., B0
RIEMRZBZRER , BB EEARMANGEEBEORS, XMNEFFIBR T EIE NN ARENE
E HiISMHUEPATERERITMERSRE (ES@http://www.otrs.com/en/references/ ) ,

1. OTRS:: ITSM:Z{RF0SC}E

BT RIEAOTRSITSMIG ? SNEEKE T~ R AEABBITLER AR DEBREEIFR ?
BERBELZITHLETMOTRS ITSMHARE £ AFHA K E 1B AR S AER 7 5 B iR [ A TIRIREER ?

BAEITRIZE R, RS, Ak, MIBESNITEEMNSZHA@EBRHE ZHRTEAE
iR, WENMBNRZSMREEREBASLINNRS AT , BRENZHRBOANARAZ

zS

AR B4

 RAERIFEKR , FihEN=miTl

o IBEITSMRTZAALLEMIIRIT 5B

* ISO20000iAIERITILIFfE S5 5

o ITILIZ)IFGHS

* ITILSEAE

» wFITARSER

« CMDBi&it

* ZRIAECEORS:ITSM , BESERINBHARSRIMEEN
s ERAMNMELERNOTRS:ITSM

* NEIERBEZIRIZFEE

© FRAFE

o FMANTERME , UKRBHOTRS:  ITSMI B INEESEERITHEESE
o RITAKIPIM B o] BBV RAEERFARS AR

o XFOTRS:ITSMIEZEIZE (ASP/SaaS) HZHRSE , WERMNBRSERE

2. R HA%

FRRAOTRS:ITSMP— PN EZMBMEY RINEEEENREE. FABLHNEIE (XEME
MAERFWHAXE ) ", BABEOESHIERNET RINGESTEEEEIZZIOTRS: ITSMAYE [ AY#K
Heit,

2 FEMME LIFMA R AR PIRER HIEIRE | BAFBHOTRS::ITSMINEEEERIFE RIE R A i
FITHSE. BANRIEIRBARINGERR, BFZEOARRBINE.
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NHEEFUBERLNT RINEEHN AT SEE UG MA R RINZIRERIR, FIEMEXIERESTE
EMRERRIOTRS:ITSM |, EEFEEEFEXRFEN FTOTRS:ITSMEZ#EKHMm KT , FR&EH
BET LBIE ISR TN AE R BT AR RO BY AR,

3. MAREFRXZS

BB R T R | ITIRSERBERALRERIRIRRMRARR, X NMBERIMAINKER
ERE—NSBSESEKHE, BFEENRZRITFMIINBERRLRABEGNINRE , UKk
AEBH SR KIS FRIEEEMNEENAREFRS.

BAREEMFE S | BIVRSETRBENERERTK , TRERNBNWNRE (RS
7*¥24*365M ZMARZHAIHIN ) , FFAET*24*3651A1 A THIZ IS~ Wik A K& el ka5 1,
FiAlElhttp://www.otrs.com/en/support/3k ST E XFHHIFHER , BT hB4sales@otrs.com
BX A TR TR SHEHIBA,

BRFENCENFTENRS (5 , FEN BRI CAFUT LERMFIRS BN EHZ 5 |, SNERE
EOTRS:ITSMEAIMN AR AR RS R,

BATENITILEEN N ATEF FHEI R e Mmt. BMNMRSZESERSIEKR , U
ERETEIRARSERWIAEME R, LERRS BHNARRSREEF XL ENELT,

4. TEMNAEFARS (ASP/Saas)

R IBAREEHIZEOTRSHI/EOTRS::ITSM , 5] BAEE AFiBRY“ASP ( R FARRSZ R ) "B “SaaS (&4
BNARSS ) REAE WL S FRAAR =R,

BF (RHERF) BEEBEMiAEANEHAOTRSAS , IFE , lREER#RBNARERF R
(EALEMEY) , AESENENEEMEAX I TNAER, BARERTHR~R , 2E5IMY
WAEZE A,

MAREFRSREHBIEEITEMIRME,. RATEMITILEIIRAE | FHRIERS RA I EIBRSS B
B, RESHEFNARS (FIINITHT. &, 8BiE) , UREEFN/ERSER (HEEER. K
T RSECERX ) WEFXZH,
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% 3 E ¥ROTRS:ITSM

BER , WITEOTRS:ITSMZ X ZRIRRIFOTRS 612, THROTRSERMAMBRER. EMNK X
MIZEMEOTRSEEF A ik

1 = M4

- IR

INZFEOTRS 6 EFIRAST , URAEERER , ERAAEEXEARKGEEERIGET ftpy/
ftp.otrs.org/pub/otrs/itsm/packages6/ FKERITSMIX 4B , HIRUTINFEE :

o BRIER

o ITSM#ZIDEIR

NREBITOTRSKIENRER LRI EEAN , sIERW FHELRIGEEE [--OTRS::ITSM 6 Master--]
RERTENRAE, SUTHTENRKESHERRGEEERREZREL] .

o ITSMEEERN B A EIRAELR

o ITSMEC B EIRIRIR

* ITSMLZEEIREIR

* ITSMARS KB INE IR IRIR

- EABHER

B BRI RRIIENESER ¢ INSTALL-6.ITSM

3

DASHBOARD | TICKETS | STATISTICS | CUSTOMERS o,

No packages, or no new K , found in selected itory.

Package Manager

Actions Online Repository
Browse_ NAME VERSION VENDOR DESCRIPTION ACTION
Install Package Mo data found.

[-OTRS:ITSM 3.1 Master-] http://fip.o[..]

T = — Local Repository

NAME VERSION VENDOR DESCRIPTION STATUS ACTION
¢ 1 b The General Catalog )
316 installed
package.
Hint The ImportExport X
316 installed
package.
The OTRS:ITSM Change X
316 installed

Management package
The OTRS:ITSM
316 Configuration installed

Management package.
The OTRS:ITSM Core

316 installed
package.
The OTRSZITSM Incident

316 and Problem installed

Management package.
The OTRS:ITSM Senice

316 Level Management installed
package.

TR

MREEARIRAZFTOTRS::ITSM 1.1 , BEERBRAHAREIOTRS::ITSM 1.1,
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http://ftp.otrs.org/pub/otrs/itsm/INSTALL-6.ITSM

MRELLRTOTRS:ITSM 1.1, THLROTRS ITSMBEIAREHIOTRS 2. 21EZRE|frRA2.3, F
#HOTRS 2.3MERMIEIAR , FIRUPGRADINGXHHIFESH R, FREIER2.42/5 , EXRFIENR
4 , ERRGEEERRETRREBITSMUpgradeTo12, EEJUFi FHERELRECE, 2
PIBXTREMZREREITSMRAEBHERER. ZMREBRHRERAEFTENRGERALRR
HRAEZIOTRS::ITSM 1.20 %A , FiTR R EEUE,

AR ITARFTEROSW | HEARETEBAEELARITIE

NEROTRS::ITSM 1.2B2%FRKY , EEFHOTRS:ITSMEIALIRAIOTRS 2.31EZER2.4, T
OTRS 2.4 WEZRMIERFTAR , FFHZUPGRADINGXXFHUIESHE, ARENEL2.427/E , ERIIEHA
4, FERGEEERRER"ER'ETHERNNREE,

BERAREELRMOTRS:ITSM 1.3, NRREEXPERREBEIEE, WMRIREMOTRSI0] FEX
W, ERTELRGEE--OTRS::ITSM 1.3 Master--IREEMIPVRAE, MREFHARALIRGELT]
A, REERHERHEER— MR,

BN, THRAEBEA ERRGEEERIRERILRGE, BS  FEHNHIAMRGE , BWEEX
i !

14



OTRS

Real Services

% 4 = OTRS::ITSMiERE—F

BEEZFEMNE—HEBR : OTRS:ITSME2ERSBEEOTRSHIRSARIEFRE (ZFA]
i) . YNIRCARIEAEORS , FIEMINENZ R (MNER. AYEE. AFPRFIRE. diEE. M
N, FAFIPRE) Eeess(ER |, ;R 8 EFE s,

AFMELNITIEOTRSFOTRS: ITSMARMAE , 532X EUTAHE :

* ITHRSZFOSLA

e CMDBECEE R #UIRE

o M TR FERFITNAEE

o BEMITILARIE

Detailed information on the settings and proceedings that are identical in both OTRS and
OTRS::ITSM are provided at https://doc.otrs.com/doc/manual/admin/6.0/en/html/ in the
OTRS Admin Manual, which is continuously being revised.

4.1. EEFH

OTRS 3.1 - Admin Manual

_,
&
=

OTRS 3.1 - Admin Manual

Copyright @ 2003-2012 OTRS AG

René Bakker, Stefan Bedorf, Michiel Beijen, Shawn Beasley, Hauke Béttcher, Jens Bothe, Udo Bretz, Martin Edenhofer, Carlos Javier
Garcia, Martin Gruner, Manuel Hecht, Christopher Kuhn, André Mindermann, Marc MNilius, Elva Maria Novoa, Henning Oschwald,
Martha Elia Pascual, Thomas Raith, Carlos Fernando Rodriguaz, Stefan Rother, Burchard Steinbild, Danigl Zamorano.

This work is copyrighted by OTRS AG. %

You may copy itin whole orin part as long as the copies retain this copyright statement.

The source code of this document can be found at source. ofrs.org.

LMK is a registered trademark of X/Open Company Limited. Linux is a registered trademark of Linus Torvalds.

MS-D0S, Windows, Windows 95, Windows 98, Windows NT, Windows 2000, Windows XP, Windows 2003, Windows Vista and
‘Windows 7 are registered trademarks of Microsoft Corporation. Other trademarks and registered trademarks are: SUSE and YaST of
SUSE Linux GmbH, Red Hat and Fedora are registered trademarks of Red Hat, Inc. Mandrake is a registered trademark of
MandrakeSoft, SA. Debian is a registered trademark of Software in the Public Interest, Inc. MySQL and the MySQL Logo are registered
trademarks of Oracle Corporation andfor its affiliates.

All trade names are used without the guarantee for their free use and are possibly registered trade marks.

OTRS AG esszentially follows the notations of the manufacturers. Other products mentioned in this manual may be trademarks ofthe
respective manufacturer,

Table of Contents

Preface

1. Trouble Ticket Systems - The Basics

What is a trouble ticket system. and why do you need one?

What is a trouble ticket?
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% 5 = OTRS::ITSMITSZITILERS
=

FRRITIL—F , ORS:ITSMAREMZITIRZSEIERTE B S IEKIES M B FFEENB"E RS
=, FX L, ENZER— 1 RiE. REBBRZIEBENERES , MEES/LFESMNMELRIEXK,

At , BRATFENIFRTENEERES : REHRE. ARTIFR (ITARSS ) #EEEIEXNFFITILA ,
ERAMSFITILW TEREIMOTRS: ITSMABE X,

AIHBAITILRIZMIE S B F AR B E B IMERIFER , OTRS:ITSMEABEIAR I THR S5 E 120
KPI ( RHBSIRNIEHT ) BITRHEA H 4x.

BENHEIANEX : INMEITILNEEERTE—FEEER., EMRSEERELERAFMISZMATR
i, B2 , HNLAER , RIGWERSXFITILNITIRS ERTRER LARENEHE , BATAEN
IR FRE B A BN IE B R E A SHIRIE.

MhRA2.0748 , OTRS:ITSM3Z 5 FEIBYINEEFNRAE (@EIRTT AITILKERIE —FER )  BFEEIE,
EIAEE, RSEFEE TEEENEESERERE.

EZHXRERMFERRMIFAEL ] AE FTENETXE, HEEZNOTRS:ITSMRXHEEREEIR
NRR , KEENBHSITILENE EE—,

OTRS:ITSMETFITIL V3L,
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%5 6 Z CMDB-HRITEE

EEERIERE (CMDB) FE— M RABX EMNEERE , MEB—MIS LMITHRE , RSMHITHR
SEEATNERN, FAENITAGFE~EHECMDBHER, BEEREBHTASEE (BEREMH
WEREIMAER ) |, BEAERMUXMNMSZMRICRATT , MEMBBEXEBHZERXR, RARSEH
S ERFS. FTAAITIFEERPRE LRI TRRSMITAS (BEED , () ZEMNBERBES.

HRIEITIL , CMDBIA TR (H LA R INEE -

« FHf (FEERHT ) BENCR/AERECEIN
o HARECEIZ B8 X R /BB EXEBIER
 [ZRECETEM (B9 : FAIS)

s EEMNUENRFER
 SRGHRIITILRIZEIRER

OTRS:ITSMECMDBHSEIL T A EFAEHEXK , FEMH S MEIMITZIFINEE.

1. OTRS: : ITSM#IEEERL

OTRS:: ITSMAYIEIRIL ZeMFN I3 IR ADNOTRS: [ ITSMIRAHIBE I (1S M LATE — KB R B /R T2
BURERE, ETEANERE , AERE REERERFOTRSESFITSMR G ELIR# T B IREIE
ﬁgo

1.1. OTRSIEZE

For better readability, the diagram can be found at: https://github.com/OTRS/otrs/blob/
rel-6_0/development/diagrams/Database/OTRSDatabaseDiagram.png

1.2. H3RIRR

For better readability, this diagram can be found at: https://github.com/OTRS/
GeneralCatalog/blob/rel-6_0/doc/general-catalog-database.png

1.3. ITSMZIDMER

For better readability, this diagram can be found at: https://github.com/OTRS/ITSMCore/
blob/rel-6_0/doc/itsm-core-database.png

1.4. ITSMEZEEIBIEIR

For better readability, this diagram can be found
at: https://github.com/OTRS/ITSMConfigurationManagement/blob/rel-6_0/doc/itsm-
configuration-management-database.png

1.5. ITSMTEEIFREIR

For better readability, this diagram can be found at: https://github.com/OTRS/
ITSMChangeManagement/blob/rel-6_0/doc/itsm-change-management-database.png
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1.6. SASHIRIR

For better readability, this diagram can be found at: https://github.com/OTRS/
ImportExport/blob/rel-6_0/doc/import-export-database.png

2. IR55 , —tIEIZID

BRSSUN“AR/AEIT TARUE", "B F R4 S "WEBI o) &R 21T fm , MiZfERAOTRS::ITSMAIfwiFEI"ITAR
FER. EE—TMRSEREEREFAEREN , AERSFREMNL. MB , AAITEWAR
(BRSASD) MITAP (FF) MEERSERNZR  ENZERAPRY. STERNESRE

iR,

82 M=
5

BR35 BRIRTTRAFMRMEIES. BITMNEZRETR  SEEFEEETFNRA LRIFHS
Bk, AFIEIRIRSEMEIOTRSITSMIFAE Z &, BENIMIREBNMNITILREEREEW
IEBRR B M B,

EOTRS::ITSMAEE 3 RMIITHRSS B REVFEG] (B85 ) , T8

6.1. RS AGIBIELH

x

DASHBOARD -snmsn::s CUSTOMERS | ADMIN Q,

Create New Phone Ticket

=Tjpe: - N - Customer Information
@ “Jim User" <jim@otrs.com= = Jim
*From customer: User
jim
% To queue:  _ -
jim@otrs.com
[~] 565 - 123 456

_ Pier s
Backups and archiving

Communication San Francisco

Desktop Management #4 Location

Desktop productivity tools © Open tickets (2
% Subject File / Print

Helpdesk

# Text:

=]
~
=
o
11
11
Iy

= | Remote access

1
1

MERFEER,

IT Operations

Identity and Access Management
Internet

Metwork access

Standard desktop

3] o0our

g
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OTRS

Real Services

6.2. RAHIE-RSHEM L

xz

DASHBOARD TICKETS STATISTICS CUSTOMERS

Service Management

Actions List

E3 Add service SERVICE

% COMMENT VALIDITY

valid
valid
valid
valid
valid
valid
valid
valid
wvalid
wvalid
wvalid
wvalid

3. AR55 % RIF0ARSS Fnl iy

BR S5 R AFNFENT AN ( BRSZSFANDIN) IERITRRSHRERIE, SIAERASEREICRIE

IE o

6.3. RAEIE-SLASIEM N

CHANGED

08/27/2012 11:03
08/27/2012 11:00
08/27/2012 11:02
08/27/2012 11:01
08/27/2012 11:01
08/27/2012 11:02
08/27/2012 11:02
08/27/2012 11:03
08/27/2012 11:02
08/27/2012 11:01
08/27/2012 11:01
08/27/2012 11:00

CREATED

08/27/2012 11:03
08/27/2012 11:00
08/2712012 11:02
082712012 11:01
082712012 11:01
08/27/2012 11:02
08/27/2012 11:02
08/27/2012 11:03
08/27/2012 11:.02
08272012 11:01
08272012 11:01
08/27/2012 1100

Top of page [

DASHBOARD TICKETS STATISTICS CUSTOMERS
SLA Management

Actions List

E3 Add SLA SLA

U TFESREENSLARTHRICR :

SERVICE % COMMENT
Backups and archiving

Communication
Desktop Management
Desktop productivity tools
File / Print

Helpdesk

Identity and Access
Management

Internet

IT Operations
Network access
Remote access
Standard desktop

Backups and archiving

Communication

Desktop Management
Desklop productivity tools
File / Print

Helpdesk

Identity and Access
Management

Internet

WALIDITY CHANGED

. 08/27/12012
valid
11:03
. 08272012
valid
11:03

CREATED
0812712012
10:57

082712012
10:58
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6.4. RAEIE-SLAEIE-fRiE

x
DASHBOARD | TICKETS | STATISTICS | CUSTOMERS Q,
SLA Management
Actions Edit SLA
Go to overview SLA | Ext Business Hours
e Availability -
M Backups and archiving -
Communication E
Desktop Management
Desktop productivity tools
File / Print -
Calendar3-24/7 -
mE | q20 {Motify by 70% =)
) = no escalation - 24 hours = 1440 minutes - Only business hours are counted.
180 (Motify by 80% ~ )
0 = no escalation - 24 hours = 1440 minutes - Only business hours are counted.
480 {Mofify by 90% =)
0 = no escalation - 24 hours = 1440 minutes - Only business hours are counted
dents | 4gp
A valid -

[ Submit o

OTRS::ITSMEARH T &2 99N AREIHY B[R 1 2 0 TIFakARSS B BRI AR ERY X, SLABETS S
R RERFEO", OTRS:ITSMe] AMARBRIEEFEE (BAL : 58 ) RIEFIEEF0FALKET 8],

. [ORZEIE ]
. = YR IR E)
. = RESBERFLIIE (RS ERETER ")

. [EEE)
. = EBANAE)

. [fRREE)
. = HREAIBSERATERMAE (“BAEERE", “MTTREIRE A" )
. = RS BREIEAE (STEEIE")

. [EiEhyERE ]
o = “MTBI" : ZER]—SLAFRERIF IS T 8 % /S 5/ & A REn B AR ),

Bk A
=0

NRSLAFRPA LA RRIRTELE BMIAE |, IRIBNOLZAT (8], “SEFAYE)"F1"RRIRE B A RS
FANEI ARG !

OTRS:ITSMAAEZERAY EEE B E T ITILA R LR EHR"
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OTRS

Real Services

6.5. tfEEasEHA

Time to repair ‘downtime’

Response time Recovery time
Detection Repair Restoration
— € > [ >  e—
Incident Diagnesis Recavery Incident
Detection Repair’ Time between
elapsed tme faslures or
time ‘uptime’

_ Time between system inodents
Time

KB : OGC, ITIL RSB 23530y

PR T RIRIAESS , ORSHETHELE(EE T — P EICKAEMNRSESLATAMNENX , XEEFHEE
RGHISLARIEBERE,

4. i EIN

BIERMFERHRPASHTTENEEI (285 ) #atEf]
6.6. k55 AR-FCEIN

+ 2 You are Ingged in as Jane Smith m

DASHBOARD | TICKETS SERVICES CHAI-IGES STATISTICS  CUSTOMERS | ADMIN oY

Overview: ITSM Configitem: Computer

Al 3 Hardware 1 | Location 0 | Network 0 | Software 0 =3

1-20f2 |
STATE | CONFIGITEMZ A| nanE | DEPLOYMENT STATE | CURRENTINCIDENTSTATE | LAST CHANGED
[ 389432000002 Al240 Production Operational 08/27/2012 11:58:58
- 389432000001 A1239 Production Operational 08/27/2012 11:57:40
Top of page [

BARENERE
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6.7. RS AG-ECEEE-1tZ

42

DASHBOARD | TICKETS SERVICES CHAHGES STATISTICS | CUSTOMERS | ADMIN o

| Configuration Item: 389433000001 — P1234

Configuration ltem Information

Back | History | Edit | Print | Link | Duplicate Hardware

P1234

= = Production
WERSION INCIDENT STATE | VERSION NUMBER | naME | CREATED BY | CHANGED | = Operational
[ ] 1 P1234 (Production) jane (Jane Smith) 0812712012 12:00:16 ]

0812712012 12:00:16
¥ Configuration Item Version Details Jane Smith
PROPERTY VALUE 0812712012 12:00:16
Name: F1234 Jane Smith
Deployment State: Production
Incident State: Operational
Wendor. Brother
Maodel: HL-2150M
Description:

Type: Printer
Owner:

Serial Number: Z21480AK
‘Warranty Expiration Date: 04/27/2018
Install Date: 08/27/2012

LEIREE Z BRG], ORSK D WMEGEHEFML B1EE, 85— EENHEE 5 —CMDBYY
&Af , ORS:ITSMERS BRI & BRI R @1,

OTRS:: ITSMiF R L 7 FheiE 1L EL ¢
6.8. RZAG-ILEEIE-1EE2

Link Object: Configltem# 389433000001: P1234

Select Target Object

Computer ~ | Select

Search NS

Expired -
Inactive
Maintenance -

Incident
Operational
Warning -

Search

EHEWR , BAERENR  RAREXEEEBFERBTNR, oI UERARNENRAERE R
%0

4.1. ITSMECEEIEMNEREO

There is a Genericinterface for ITSM Configuration Management. This feature
contains operations for creating, changing, retrieving and searching configuration

22



items via Genericlnterface. The following operations are available: ConfigltemCreate(),
ConfigltemGet(), ConfigltemUpdate(), ConfigltemSearch(). For more information please
take a look at the WSDL file: https://github.com/OTRS/ITSMConfigurationManagement/
blob/rel-6_0/development/webservices/GenericConfigltemConnectorSOAP.wsdl

5. XHEMERE

EAFAQAR L (MOTRS 2. 1IRAZ/FMITHIIMERIELR ) |, B] AR AN E IR AN A/ I RER E AN
HIRH—EARBIREE,

M ETCA AR ER TXAEMER. MBEEFERSATER. MRERARBIESHEREITLIE

AR, MMANENREFUBERS AR E, sJUEEERRREENRERITHINENENE
BEMRG, FAENXEEBMARSIURESERNE,

6. ZIERRAMSENZI]

IRREA G R AR |, F Y REBUIERE, BMHEZRENE. FRER I UERFMAV'ORSITSM
AR B OOTRSEEFMA RAEIR D EE,

B H=
s

CMDBEEHRAINEHPERENE ETIRNRT , AR RRMAIES. BIMNNERETR . S
BHFELANEITEMIRME ERIEMERE , X ZEBEEROTRS:ITSMBIEREFECE
INZE, CMDBi&it{EENIMERRYESENUNITILSEE T RE LWRIEPAR B MNER.

7. TRXRENES

EOTRS 2.2RASIATEEMN T BER |, thEOTRS::ITSMAER, EHRATIBLRMITILFRIZR ,
T EEHATHE,

OTRS::ITSMIELE Z ERRASLIMBIFABITILARTE , FIMNEEERE , hiiXNF5ASRM, PJUeIZT R
SRRUYNRFC ("TEIFK") .

6.9. RFEIE-LAEIE

i

DASHBOARD | TICKETS | SERVICES  |CMDB  CHANGES | STATISTICS | CUSTOMERS Q,

Type Management

Actions List
3 Add ticket type NAME VALDITY CHANGED CREATED
- valid 08/27/2012 10:49 08/27/2012 10:49
valid 0812712012 10:49 08/27/2012 10:49
valid 08/27/2012 10:49 08/27/2012 10:49
valid 0812712012 10:49 08/27/2012 10:49
valid 08/27/2012 10:49 08/27/2012 10:49
valid 0812712012 10:49 08/27/2012 10:49
valid 08/27/2012 10:51 08/27/2012 10:51
valid 08/23/2012 14:26 08/23/2012 14:26
ot
= H

A THROTRSITSMEEMAEN —HE , ARAEEXLIRNEETEZ—RMANER
bR, WMRFBRNBEILES , FERFRETN BT TR0 G 2L BN =T,
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Real Services

£ 78 RSEe. NEEEMOAE

RS & (EITILRRSERE—MRiEmE — 118 ) 88 I%%%E’JIE?B‘T %, FTEREZ%HE
EMAEBITER A ERMBASEXELE, [TILRSEERESRIEEERN , A TS5
FEEARSIERERNIESR. ER. (I8) ARMN/HFRHE.

OTRS I TSMARRYEEPE TR F0 (0] 3 EIE,;.JEE%HL}Eﬁulﬂukmno ErR , ARPRFtHREEEER
, RBOTRSHAREHR]EERER

1. THEE HRMREEK

FRIETER (BMMERAZR—RIELE ) B TENEZEEFEROTRSHIMINGESIEM :

« THXER
« XS
* SLA

. FM

s L%k

BURTIERBIARSS | ﬂ[‘]%ﬂﬁt?ﬁ&%ﬁzel ZRE-HM-AEREEPEMNER. BR  SMTRSA
RERNFIEVIP"E PRI,

ATHEREENRSZERK , BHNERFEFNRE—MBERIMLER.

7.1. RSAGR-CIETH

Create New Phone Ticket

*T¥Pe"  ncident:ServiceRequest - Customer Information
9@ “Jim User” <jim@otrs.com= [S] Jim
*From customer: User
T jim
* To queue: i
Service Desk ~ jim@otrs.com
File / Print hd 555 - 123 456
- Pier &
: San Francisco
Smith Jane (jane) -
¢4 Location
T @ Open tickets (2)

* Subject | Requestfor new file share Marketing Callateral

% Text:

Es=s== g "

- — - A- - 2| Source -]

=
b
(=]
o
11
11
I
1y
i
i
il

In order to et the MAR team collaborate more efficiently they would like to get a separate file-share for
Marketing collateral.

Kind regards,
Jim User

BT TEAREE , TSR TREMIFEREL. [TEBXNMERIESSHEIGD
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7.2, RS AG-TR-HIRIEN

44’

DASHBOARD TICKETS SERVICES CMDB CHANGES STATISTICS CUSTOMERS

| Ticket#201208273894000014 — Can't access VPN from home location
1 Article(s) Age: 1 h 42 m — Created: 08/27/2012 11:05 by Jane Smith

Back | Lock | History | Print | Priority | Additional TSM Fields | Link | Owner | Responsible | Customer | Decigion | Mote | Merge |

Pending | Close | - Move - -
=1
| no. | Tvee | = | FROM | suBJECT | CREATED | o |
1 customer— O+ Jim Cantaccess VPN from 08/27/2012 ]

¥ #1 - Can't access VPN from home location Created: 08/27/2012 11:05 by Jane Smith

Forward | Phone Call Qutbound | Phone Call Inbound | Spit | Print | - Reply - -

Jim User
Service Desk

Can't access VPN from home location

Get error message 'Usernamel/password do not match”

Ticket Information

Incident
open

unlock
Senice Desk
Jane Smith
Jane Smith

Metwork access
Ext Business Hours

17 m

08/2712012 13:05
1h1¥m
08/2712012 14:05
Bh17m
08/2712012 19:05

Swvery high
3 normal
4 high

2. SLAMXHIBS B[R

EFMINAYITSMFER e | AEFSICRAMECKSLARZEKAINDAZEY (8], SEFFAT(B)FNERRAT (8] :
7.3. RSB AR-TR-fHN=FER

Change ITSM fields of ticket : 201208273894000032 - Request for new file share Marketing Collateral

Opt\ons
*Title: | Raquestfor new file share Marketing Collateral
08 ~/27 v/2012 » G- 12 v 59
08 /27 v12012 + [3- 12 »- 59
08 »/30 v12012 + [H- 12 »:59

_ Submit |

PELE (BAF)

RIFATE BRI REY |, ORS:ITSMBASIRIIRIB(IRAVLAQIEMSHITHH, FINRAEELAR-RSZE. —
. :ifﬂ_?&ih( ZEAEITRSFFHER)  SEENETIREGAPEERENS-L
B, . XAFEAIE,

50TRS 2.2ARTRIAR AR KR , OTRS:ITSMAEY T8 FH & e B T SLARR R AL AING AT (8], 58 A (E)F]
RERTE, WNRSLAREHARRBIETE , FLEET AT K BASIHIET (&),

ETENEA TR G TRERE —NEEIEAT,
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Bl 7.4. RS A53-TE-AF

DASHBOARD

QueueView: Service Desk

Service Desk (2)

STATISTICS

CUSTOMERS

ADMIN Q

=] 1202 | s [ L
[7] Ticket#: 201208273894000014 - Can't access VPN from home location
J From Age Queue First Response Time Update Time Solution Time
Jim User 3im Senvice Desk 1h 56 m/08i27/2012 13:05 2 h 568 m/08/27/2012 14:05 7 h 56 m/08/27/2012 19:05
To Created State Type Priority
Senvice Desk 08/27/2012 11:05:48 open Incident 4 high
Subject Owner Lock Service CustomerlD
Can'taccess VPN from home Jane Smith unlock Network access
location Service Level Agreement
ExtBusiness Hours
[l Ticket#: 201208273894000023 - Please restore K:\Accounting\Overview.xls
_[ From Age Queue First Response Time Update Time Solution Time
Jim User 3m Senice Desk 1h 57 m/08i27/2012 13:06 3 h 57 m/08/27/2012 15:06 20 h 57 m/08/28/2012 17:06
To Created State Type
Semvice Desk 08/27/2012 11:06.46 open Incident:ServiceRequest 4 high
Subject Owner Lock Service CustomerlD
Please restore K\Accounting Jane Smith unlock Backups and archiving
\Ovenviewxls Service Level Agreement
Std Business Hours
Top of page [

[

==
[=]

PAZIZRMAYIR T B A T HAREAVES, BAINERER . SREFREOTRSITSMZAIE
FEMBITERM IR LIS EE, PAIRITTHERNSN SRR ESBNAIOTRSERITILE R EREE
WAEBRR B MERY,

4. 2t T

N TEMABIEIRSOTRS—# , BT Sz FARHERRHT,
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Real Services

7.5. RSB AR-TR-BIRER

+ Y 1 You are logged in as Jane Smith E]

DASHBOARD TICKETS SERVICES CMDB CHANGES STATISTICS CUSTOMERS ADMIN Q

| Ticket#201208273894000014 — Can't access VPN from home location

1 Article(s) Age: 1h 42 m — Created: 08/27/2012 11:05 by Jane Smith Ticket Information
Back | Lock | History | Print | Priority | Additional [TSM Fields | Link | Owner | Responsible | Customer | Decision | Note | Merge | Incident
Pending | Close | - Move - - ZDES
unlock
= Senice Desk
E
Jane Smith
| no | TveE | = | FROM | suBJECT | crEaTED | © | Jane Smith
[ 1 customer— O+ Jim Cantaccess VPN from 08/27/2012 ]
Metwork access
¥ #1— Can'taccess VPN from home location Created: 08/27/2012 11:05 by Jane Smith Ext Business Hours
Forward | Phone Call Qutbound | Phone Call inbound | Spiit | Print | - Reply - -

Jim User = o
Ua, 2012 1500
Service Desk )
. 1h17m
Can't access VPN from home location 0812712012 14:05
Gh17m
Geterror message Username/password do not match™ 082712012 19:05
Svery high
3 normal
4 high
0

5. EHFRE

ERZHIBAT , HAIRRSER , EEREMIIDIEERE, BURTRER , sTHRSARE
EMERE (IWEEE)  SEEISELENFMERE, TERNREE (U—1AFBED
B —NZFROXEGR AR R ) B EBANBER (MNRBIFPEICERR ) FEHH.

OTRS::ITSMARttEFIELLER BT RE 1% , HRKAFEETLSS .
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7.6. RSB AR-TH-RE

Change Decision of Ticket : 201208273894000014 - Can't access VPN from home location

Options
#3ubject  pecision

#Text:
B I U § i=1 E=E==%= . L

1
=
4

| Source 4

Reason:

Browse_

note-internal -

Approved -

6. NHETREIE & LR

EN—PHSMRETRLZ— M EETE | Sl — M TR EAXMSRETS, @i
737, MRAEFERT AR IMALIE |, AV EREINEERXA TR , REWRKARRRTI R,

WEMLDE TR SHE LS FEEIRREEWE , FEITIRSVEHIFIFEMHE 21,
7. TEXF
AMGOTRSHRAERR , OTRS:ITSM{E A T HEHER(E 3B MITILAY T B x4,

8. HAk551ERRIALIE

EFOTRSH , IRBIEKRFNWFEE SF L RREIEFVIBAIE, Ef1e@i LT EEE Incident::Service
Request ( #4f&E::ARSZ1EK ) MIFEIREK S ,

AP AREZRSLAER IS (8] |, FEARSS RnIFARSS A INER D B EIF AR,
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7.7. BlRS3 AR-BRS51ES

+ 3 a 1 ou are

DASHBOARD TICKETS . STATISTICS CUSTOMERS ADMIN Q

SLA: 24/7
SLA Information
Back | Print
0812712012 10:57:21
v SLA 247 Jane Smith
Avalability 0812712012 11:03:43
Jane Smith
Calendar3-24/7
120 minutes
120 minutes
240 minutes
240 minutes
Associated Services
STATE SERVICE TYPE CRITICALTY CHANGED
| IT Management Svery high 08/27/2012 11:03:24
[ | End User Senvice 4 high 08/27/2012 11:00:31
| End User Senice 3 normal 08/27/2012 11:02:50
[ End User Senice 3 normal 08/27/2012 11:01:19
| IT Operational 4 high 08/27/2012 11:01:03
[ Back End 2low 08/27/2012 11:02:20
| IT Operational 2 low 08/27/2012 11:02:33
[ | IT Management Svery high 08/27/2012 11:03:09
[ | IT Operational Svery high 08/27/2012 11:02:06
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F8E TEEE

RIBITILWEN , EEEER P RSERARE , BNREERTEE , SFEEITL. XEMEdit
ERSKHE. BARRREL I TEMIREAHR X BIRSE N IR S RENTE/ERFHRIGDEmSMN ,

1. TEEERRFK
1.1. $EHEUMIR

SEMEOTRS:ITSMEXREZM AR EE TF, ERAERZA , EEEEREMNXBITRIY
ZEMTIIER. EEETIRROIE X,

1.2, HAREK

ST EEERREFE TIRMG

1. OTRS Framework, version 6.0.1 or higher

2.ITSM "GeneralCatalog" package, version 6.0

3.ITSM "ITSMCore" package, version 6.0

TIHREEREFLRN , ENRABEEHETEYVE :

e [TSM "ITSMIncidentProblemManagement" package, version 6.0
e ITSM "ITSMServiceLevelManagement" package, version 6.0

e ITSM "ITSMConfigurationManagement" package, version 6.0

* ITSM "ImportExport" package, version 6.0

2. OTRS:: ITSMATESEMER

OTRS:ITSMAMBEEELMEX — P REHZRNIMBITRER —LE0R , FlilRER—EFHEIH
rARSS 5.

EANTEEERZZSNFES , ORS:TSM AFESNEEFRINEZTHENFES |, XLEFESRH
EFFBIIFES.
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OTRS

Open Technology
Real Services

8.1. TE-TRIESERN

Workorad
Workord

O O
— —
O O
" '
— —
O O
s =

3. TJRAMNAFAEE

BT ESEEREETETRENINHSREE, SENAPARBTOTRSAASIERBIE,
8.2. OTRSHE-AE

P

O
duese?
—

O ro, ¢, mv
—

— pe—————————— P
/\ L Role myv, owner Queue 2
e 3

i

w

Queue 3

Queue 4

TR RABREBSFILAIOTRSREER , SEMEIRTRPAFA !
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* 8.1. AFAE

RAFft

3ia] A PR

itsm-change (ITSM&E )

XARAPANMRABRADEEERRIR, E
TRESHEBERS ARBEENEEXME,

XLERAFEEEMEMNTENTIFRES.

itsm-change-builder (ITSMEESIZA )

FPERR R BN EEMNEENTIFE

XA
P
<o

XMAREBERMENEEMIFRES,

TEABACBTEMIFRS  HEREX S
""E@JL)&FE“%F’TLAQF‘EE S B T IESE

| 4 1

itsm-change-manager ( TELZIE )

/|\FHFéﬂﬂﬁﬁiﬁﬁﬂﬁﬂﬁ%ﬁﬂ’ﬂEE%DIFF}E

N
~o

XNMAERBERMBNTENTIFES.

LR AR BNRENTFES.

4. Eu TIERT=E

—I LR (BEMERENIFE

8.3. TETFintE

<) FUZBFEAEM TIFRERIT.

 Creation of a change

+ Creation of needed work orders

Definition of conditions & actions

« Execution of a change

5. BIE— 1R E
5.1. HTEE

REE—RE , BTHEMATIEN.

32



* 8.2. TEREM

Bt

3

TitletRER

EEEt / EERM

iR

TEMFANF L

B

TEERMIEZMRAXARRE, O
EXANe) : "GIRAEMEX A
TE , RAUENERETA?"

Pl

EXTERIEE , Fl40 : "3-1F

™ o

#

Pl

TE XX A3 5B P] HERIRA R 3R
m, a0 a-5,

RER

Pl

EMXANEEHIL AR , F1905-
FES"

RS

Pl

Helg— M EER , 2850
RENRS, HER—IEBEEE
B, DECIEAMEEZIETLL
FINKERT. ATREIRSHNLS
SRRSEEMIPRSIRENX ,
2% 53 T TERSH
" [34],

EPEREH

MRFEAE , ZNEMERT AR
iT“ChangeEdit4Rig 25

E”, “ChangeAddiFNZE
E"f1"ChangeZoom T Fi¥ 5" 1%
R RFRERNNE, XNEMHE
BREFHIEERSCHE B HA,

hiEs

&

FEVFBNAE KRS FISIAS,

5.2. X3l - ®2M0 - {755k 6%

NHE—NTEHIMES , ORS:ITSMZF5EE B AMERMMEFER —MRIBRER (BETiE

FERIZEAIFIHEAR

8.4. TEIEM

Priority allocation
IMPACT | CATEGORY
1 very low
2 low
3 normal
4 high

5very high

| Submit_

1 VERY LOW 2 LOW

1 very low - 1very low
1 wvery low - 2 low
2low - 2 low
2low - 3 normal
3 normal - 4 high

3 NORMAL

2 low vi

2 low
3 normal
4 high
4 high

-

-

-

-

TEFM) , MR RTHTELIRAMNES.

>Z T

4 HIGH 5 VERY HIGH
2low - 3 normal -
3 normal - 4 high -
4 high - 4 high -
4 high - 5 very high -
5very high - 5 very high -

LTRBATNZET, MK ERETHRAAEEREEREEPES, hTHIX—5 , EEA

OTRS:ITSMEBEEREPEERREZE"HR"
T EEIE T

LRTTE , ORS:ITSMEEEIREMIERFER"ER"BFIE :

5.2.1. ITSM




1-3EEMR

4=
* 5-FFES
5.2.2. ITSM::TEEE 20
TRFTME , ORSIITSMEEEIRAR T HOEFEFER MM A T IIE :
. 1-3EEIE
« 2-1%
. 3
.4
* 5-FFES
5.2.3. ITSM::TEEE LR
TG , ORS:ITSME EEIRAE R IR FER AR BITIE :
« 1-3EER
o 2-1
e 3-IFE
4=

. 5
5.3. TEIRSH

OTRS:ITSMEM— MBI AT EX — P LBENBERRSHAENERRS, RERRET TN
ZEEAREY A R B INHVARTSL
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8.5. TWEIRSM

canceled
requested
rejected
retragted [
-z .
pending pir
pendin priaval
approyed

SRSHMIAR BT AAREERERAERAASIER AN IR RS PR , aJEXETE SCIRSH
BIREMIERIRAS, 7EOTRS:ITSMAR |, Fi—ARIERIEA :

8.6. TERTLEH

Admin State Machine

Actions Overview over state transitions for ITSM::ChangeManagement::Change::State

Go to overview STATE NEXT STATE DELETE

- Requested
In Progress
Pending Approval
Rejected
Retracted
Approved
Rejected
Retracted
*END*
Retracted
In Progress
Canceled
Failed
Pending PIR
Retracted
Successful
Failed
Successful
*EMND*
*EMND*
*END*
*END*

EEEEEEEEEEEEEEEEE LR

WERA] A MEMYRS , BERBEN'BR"->"ITSM: TEEE TE KT,
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5.4. EXS5&AR /| TEAR
EHATBINEABIER , THTENS 5 ARTIEREARIEREL,

8.7. TEMEXAR

Involved Persons

* Change Manager:

#* Change Builder:

Submit

Change Advisory Board

Current CAB

TYPE
Agent
Agent
Customer

Jack Brown” <jack@otrs.com=

Jane Smith” <jane@otrs.com=

- = | Apply Template || Save this CAB as template

LOGIN

joe (Joe Johnson)
mary (Mary Mars)
claude (Claude Green)

XEBRGRME TBIERNE P RIRHRS A REHRINSQLEIEEKLDAPE KRS HIERE D
a], CABF[i&ET EBKICABIRIR PRIEE X

* 8.3. HXAR

B WEFER =3

LEZIE = BRI ARDEHRIRERN
LEZIENR.,

TECIEA = TE X BIEFIAIE S AL ERIARSS
AR, SHElE- MRS ER
SHAIRS ARBHIM AT ERE
AO

TEZWERS & EX—HBERS AREFEX
RABIABL,

5.5. £

HHRRITEBEN

BITOTRSAESRZBHIBEENSG] , RAARTF— N EFHER 118, IHTERRNETIFKE]

AHMBRESIRAHR,
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8.8. TESRFCHIX A&

Change Management Incident- / Problem Management

Change

LEIME R AN B E IR S A EIERIEERITAEXNEE, EXMERT , RAKEIE—1
TEMEERERDERE, TTUERREEFRFIIERNAIRS AR A ECIETE, L] ARG TE
KRERFC'RETEEERNIRS ARAEER, FEEU THWARARE RN :

* Core -> Ticket -> ACL -> Ticket::Acl::Module# ##200-Ticket::Acl::Module

* Core -> ITSMChange -> ITSMChange::AddChangeLinkTicketTypes

* Core -> ITSMChange -> ITSMChange::RestrictTicketTypes::Groups

5.6. EMXFMH

OTRS:ITSMATE T BB/ TIFESHBME XFUTERE. NRAREERMIFIUNEELIZA
A B REX LR,

AIAERXEEX TR Fl, SER— N TFESHIRERENEE N B N B REZ/MES
PR TAEIRAS,
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8.9. TE-FM

Condition

Expressions

OBJECT

Change
Workorder

Actions

OBJECT

Change

Change

) Any expression (OR) @ All expressions (AND)

* Name:  Tast Conditions
valid
SELECTOR

20120828389400001 -

any -

SELECTOR
20120828383400001 ~

20120828339400001 -

-

ATTRIBUTE
Category -

Workorder State -

ATTRIBUTE
Change State -
Priority -

OPERATOR VALUE
is - 4 high
is - Canceled
OPERATOR VALUE
set - Canceled
set - 5very high

TEIBNRE  TEERERBENMIFRITRGE , MEBRFMHIRERINFEIBRE,

5.6.1. LEHFIEAHEY
ETELRA , TR TENEMRE XFH.
= 8.4. TEL I ]HIFEMG

DELETE
hd m
hd m

DELETE
hd m
hd m

TEEM

BARIRIFTT

& FAAY (8]
TRITFE

INF

]| =

TEEIEA =

TERS

=2

RER

LEZRE z
EN =
h=

S E
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TERM

BARIRIETT

LB

... FF34
BA... 455K
2]
N2
=
R
Vo ES

5.6.2. T{FIE<HnIa] ARG
EIMFIESES TR TENEIERE LS,

& 8.5. TIFHE<SRHITAMFRMG

TFE<EM

BARIRIFT

o FAY (8]
I TFE

=
=

R

Mz

RHzs
ATF
INF

TIFE<SRmS

=
=

e
XF
INF

TIERS®S
TrREo%R

TIFESIRS AR

=
=

RE

TFE< IR

A...FF 88
M...5ER
2
N2
=
=
A=




TFiE<EMS BARIRIETT

EVoES

—— =

5.7. TENMIEE

By EMHfE , ORSITSMAF AHBISERE/— N ILIEIESENXNEEHENIRIE,
5.7.1. TELRHI]AERVIEIE

BEWKETARIT FEAVEE. MREXNFGRE , BIEFIREEERNEHIRE N —MEE
B »—FHE, BFEFNEERGTAERESERNEY | fIIREEITFNRE,

& 8.6. LERHIFTHIIRIE

TEEM 1RfF

eS| RE

20

RIER

TERE RE
WE

5.7.2. TFE<SHnI°TRAVRIE

TFE<SWRAI AT FEMRE, MREXNFEHAE , BEFIREEERNEMIREN -8
EME, »—HE , BEFHNEEFRERERAEERNEN  OIIAEETFINTE,

& 8.7. TIFE<SHRHIFIRIVRIE

TIFE<EH 1B
TFESRE RE
BE

5.8. EFTH (IR ) — BRI IA/4ERATIE]

SERRIMERR |, T RIBTE A/ 45 R E AT REMRIE R, RARVFEE IR BT B oA 8] 4h " THHER S:
ML EH.

BTRREFE , TEEEAT AR TE SR 8] 5R,
8.10. LE - a)4H

Move Time Slot Change# 201208283894000012

Planned Start -
08 ~/20 /2012 ~ [3- 09 - 00 ~

Move
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6. SIE—FRIFES

E—ANEER, RARETRNIERESE , sJUE— M MEENTERIESHENFES (B
THEES
6.1. TIrIESMEN

—BRIBT—1EE , INMLEXLMREMB—NMEXFES (LIFES) NER , AJUHTERIZA

REGILETFIES,

& 8.8. T1FiESHIEM

Bt R ER E3H

TitletnH = fEEHR /| TIEHE<BHF

Fi%15BR & TS HIFM AR

TRESHER = EXTFES ;‘Eiﬂ’]ﬁhﬁﬂi@
giEEHt, TIFHE<. PIR (3KiE
FHE) FF,

] = I:EXREE’J*FU f5gn - “3-1E
f% )

=2 = LERM R , W0“4-
'E.]"O

LR = TESOXNEERMESR , FIa0“5-
FEES"

RS = HERIE— T EN , BagE
LERS. AENEETENT
BEERAMEEZIETUFNIR
ETE'H(/L.\O _J-FﬁElJ’lj(/u\ﬂj-F_
'lj(/u\LJi;EEYIEIJ'{k/L.\HIZEX ' %
% 53 T “ TWERSH
" [34],

EFEKRBH & MRFZNE , }='T$TLXJ_
ilr“ChangeEdlth'E
B ChangeAddm\\DDg
E"#1"ChangeZoom T E 15" 1%
IRERBEENHE, XNEMH
EREFHAERSHE B HA,

B4 & FEVF Bt D0AE SR B ST FISTAE,

BRTXLEEMZIN , TIFIESHERS ARE

SRR ARRES ST,

6.2. T{FiE<kE

TEATIEH

o Hilt

- TFE<

. W

* IRE

EORB BHFZBEREOTRS ITSMEERIRITER

A a] LA

HRE"THEEWEEY | FHARRFESH TIE

KZIGFA T B,
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* PIR (3XE/R & E)

RAEERPIUEAEXEELFESRE , Erl BURIIFIZEE,

6.3. TRIE<IRES

OTRS:ITSMiEft T TFIE S BMBVRS L ATEER T —IRSHIIREH, iRERREET THZEEE
B PR H IS

8.11. TE-TFIEL-IRSM

ready

o=
acce te/d/
in“grogress
J g nlnsed
nc Ei:1ff,d—Ff“’;f}FJ{::::th__

cr d

E’Jé*%ﬁ(uo ?_OTRS ITSM':F| B— A?E’f“ﬂ%hﬂ

8.12. TE-TFIE<L-IREM

Overview over state transitions for ITSM::ChangeManagement::WorkOrder::State

STATE MEXT STATE DELETE
Created
Accepted
Canceled
Ready
Canceled
Canceled
In Progress
Canceled
closed
*END*
*END*

EEEEEEELE L

MNEBRIEHE |, B]@ET R BRI E A B R"->"ITSM::ChangeManagement::WorkOrder::State”xE X B0
RYIR,

6.4. EXTEESHIARS AR

BATHEESFIIMAES— M IFERESRSAR"  IAFERITINTTERESHAR,
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RRM T VI TR ERNRS A RS,

ELUFEEM - RExeisitsm-changeBTEEIE"4H
BRI R A & BR K,

8.13. TE-TFIESHRB AR

~

aal

“Jack Brown” <jack@otrs.com= (4)
“Jane Smith” =jane@otrs.com= (2)
“Mary Mars™ =mary@otrs.com= (5)
“Admin OTRS™ =root@localhost= (1)

6.5. TFESTHRSARRS

DEMIFERESRIARTEEXERMER. KRLFES AR B, FEALIERE
IRSBEMXERR,

8.14. TE-TFIES-IRSARKRSE

~

Report
Report: = . = [ = [ = |[ =
IB I U | = iT == === @ #h U
i Format ~| Font ~ | Size ||| Im - d- | 2 ||| = Source
State: Created | %]

6.6. iR T{FE<SRIREIVARS
OTRS::ITSMAHFE— TEHE S HEEIREI BT,
ERERRD , — M LIRS TURSRE TEONR |
- BEW
- BRI EH

FCETE-HE M

FCEME-E

FCETPIZE- 2%

FCE -4 1
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s RS
- T&

These settings are defined via SysConfig under "Core -> LinkObject" and can be extended
when desired.

6.7. BF— 1 ILIFRESREFHER
T T (15 RS IR TR Mg — A TEIE S RIZ IRIR,

IHEEPFZ LB R AREERBMAER(TIE), —BRAP K& RN ZHEBEAHEE  XMTE
1B RRT CATE I FTAY TR 38 SRME R ARIR(E A,

&l 8.15. TE-TIFE<S-ER

Template Name: | proyision new server
Comment | standard template for provisioning new servers
Reset States: [

Validity: valid -

6.8. MFR—1ITIE:E<S
SENR AT — NEEERAREANTIEES (SHEXREES ) .

8.16. TE-TFE<-MIFR

Delete Workorder# 201208283894000012-2 E3
‘You can not delete this Workorder. It is used in at least one Condition!

This Workorder is used in the following Condition{s):

Check WorkOrders

7. EELERNA

BIR— N LEMEEXNIIFESE  RAMFIUERSEXNMNEEHEXNWEERER | SFEMAXTIIFE
<. BEMNTIRMNEED,
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8.17. TE-FI5

| Change#: 201208283894000012 — Replacement of VPN server in HQ

Change Information
Back | History | Print | Edit | Involved Persons | Add Workorder | Conditions | Link | Mowve Time Slot | Template

| Request
=
0812012012 C
1
- 0813012012 1
= ' _
082002012 08222012 082452012 08/26/2012 0ar2ar2012 0813042012 -
0%:00.00 10:48:00 12:36.00 14:24:00 16:12:00 18:00:00

. 10/01/2012 1
¥ Change - Replacement of VPN server in HQ

The VPN semver should be replaced by a new one. Add some lines here. 300.00
The current serveris getting too old and slow. 0.00
2 normal
3 departmen
4 high
jim (Jim Use
jack (Jack Br
¥ Linked: Configltem (Computer)
jane (Jane 5§
INCIDENT STATE CONFIGITEM# NAME DEPLOYMENT STATE CREATED LINKED AS
; -AE- joe (Joe Johr
| 51245 Production 08/28/2012 10:45:59 Mormal
- 84522 Planned 08/28/201210:48:09  Normal Aoy LY

The defined Work Orders are numbered in order of their planned execution and displayed
in a timeline. The color of the displayed Work Order in the timeline reflects their type,
and can be customized via SysConfig "Frontend -> Agent -> View -> ITSMChangeZoom -
> ITSMChange::Frontend::AgentITSMChangeZoom## #WorkOrderGraph" as required.

RENBNTIFESETENEM EERAAERSE , LEIASEEFART LN IR S KGR
8] , FHEEYXEER R RSP TFFE < SChEhT i,

SATIERSIORSRIGIRT , R TE S :
- e - THEESBoR

- e - TIRES SHE

- B - THRES XA

It - THRES A
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8.18. TE - HY[a)4H

| Changed#: 201208283894000012 — Replacement of VPN server in HQ

Back | History | Print | Edit | Involved Persons | Add Workorder | Conditions | Link | Move Time Slot | Template

[ |

[ | -

[ | |
082002012 D&222012 02/24/2012 02/28/2012 D82arzuz 023002012
05:00:00 10:48:00 12:36:00 14:24:00 16:12:00 18:00:00

¥ Change - Replacement of VPN server in HQ

escription: The VPM server should be replaced by a new one. Add some lines here.

The current server is getting too old and slow.

8. THEME

OTRS:ITSMIB It T 2MA N REBLRAATPRENTZE, JUREEEZAZXLLEMERIAE],
8.1. THEMRE

A IMERUEEOPRERMENEE |, AN BIRHAFEFHEF.

8.19. TE-Hi

Overview: Changes: All

m Requested 3 | Pending Approval 0 | Rejected 0 | Approved 0 | inProgress 0 | PendingPR O | Successful0 | Faied 0 | Canceled 0 | Retracted 0 3

IETTER] < |
STATE | CHANGE# ¥.| CHANGETTLE | CHANGEBUILDER | WORKORDERS | CHANGESTATE | FRIORTY | PLANNEDSTART | PLANNEDEND
Replacement
[ | 201208283894000012 of VPN server  jane (Jane Smith) 3 Requested 4 high
inHQ
Migrate
= 201208283894000021 GTRSIEH jane (Jane Smith) 0 Requested 2 low
environment
to 3.2 bet]..]
Implement
OTRS ) )
[ ] 201208283894000031 . X jane (Jane Smith) ] Requested 3 normal
interface with
SAP Solutil...]

08/20/2012 08/30/2012
09:00:00 18:00:00

The columns can be defined via SysConfig "Frontend -> Agent -> View ->
ITSMChangeOverview -> ITSMChange::Frontend::AgentITSMChange###ShowColumns"
with the following available attributes:

* 8.9. TEMR

Bt #iE E3

SRR FF 4R AT (8] =) SKHESE B 9A R B HAFNRT (8]
SEPREETRAY ] & SEME T 5B 45 SR B HAFN A /8]
Bx =) LB HENEE
TECIERA = TELBANRBTF
LEZIE = TEZRENEF
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B A& #15

LTERS = RREMNTERS

TERE = TERS

TENRSRES = RUIFST ERIBEIRSIE R
LE el = LTEHRM

BT 8] =) Bl T ERTAY B BAFNAET (6]

A =) LTEHITREARIR

T XU F aRET (8] = T XU SKhE 3R 5B A9 48 B HAFIAT (8]
TR AR E] = Pt Sk e 22 5B R 45 5R B HAFNAY (8]
TR = ROl Bl

R 15 (8] =) EPEERCHE HER

ARSS = LB MRS

TIFiE<% = TERRNITIFESHE

Additionally, the Change Overview can filter and display changes according
to various attributes. The following filters are available and can be defined
via SysConfig "Frontend -> Agent -> View -> ITSMChangeOverview ->
ITSMChange::Frontend::AgentITSMChange## #Filter::ChangeStates":

% 8 10 TE*E%B_,': X /lh\%%

Bt #15

SRR ERRESHEBRIABEERE
et BERREAFEM"IAERE
wiede ERRERBIEL'NMELE
Bid e BRRSH ELEM FIFEEE
SbIEFR ERRERCEFHMERE
Y] ERRER BN FRERE
K BRRER KK HIFRBEEE
BH ERRSHEE'TMBEEE
fm ERRERHEFRERE

8.2. LEITX
SEHUMESR , RRFERSN B S 0B BTSN
8.20. TEItX|

Overview: Change Schedule: Approved

»
TR < |

STATE | CHANGE# | CHANGETTLE | CHANGEBUILDER | WORKORDERS | CHANGESTATE | PRIORTY | PLANMED START A | PLANNEDEND
Replacement

[ | 201208283894000012 of VPN server  jane (Jane Smith) 3 Approved 4 high
inHQ
Implement
OTRS

= 201208283894000031 ) jane (Jane Smith) 0 Approved 3 normal
interface with
SAP Soluti[...]
Migrate

[ 201208283894000021 010 et jane (Jane Smith) 0 Approved 2 low
environment

to 3.2 bet]. ]

08/20/2012 08/30/2012
09:00:00 18:00:00
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The displayed attributes can be defined via SysConfig
"Frontend -> Agent -> View -> ITSMChangeScheduleOverview ->
ITSMChange::Frontend::AgentITSMChangeSchedule###ShowColumns":

&< 8.11. TEitX

B A& E3E

SEPRFFaaRTE] =) SEHE T 5B FF 4Rk B HAF0 AT ]
SEPREETRAY ] =) LB LT ALk B HAFNAT ]
EES & LEHHKENKE

LTEEIEA = LTEREANBF

LEZIE = LERENEF

LEERS = RBEERNTERS

TERE = TERSE

EENRBES = RIZT B RWBEIRSIEREE
LEIRA = LEHIRHM

B AT E] =) Bl T ERYAY A HAFNAT (&)

AL & LTEHITRHARUIR

papdbag il = T XUSEHE 25 5B B9 7T 4R B HAF0AT (8]
T XI5 RAT 8] = it 3 B SEMESE AR Y B HAFNAT (8]
RFER = LTEMMR TR

FRi5 R ] & P HIEBRYSChE H HA

ARSS = LB MRS

TIFE<S® = TERXRNIIFRESHE

]

8.3. PIR - I FEE
ENMEERER R PIR'IIFIES , sIARGIIREKIEF R FHEF LIEES,
8.21. TE-PIR

Overview: PIR: All

m Accepted 0 | Ready 1 | In Progress 0 | cloged 0 | Canceled 0 =3
1-10f1 |
STATE | WORKORDER# | WORKORDER TITLE | CHANGE TITLE | WORKORDER AGENT | WORKORDER STATE | PLANNED START ¥ | PLANNED END
Replacement
Postimplementation 09/07/2012
[ 201208283804000012-4 . e of VPN server Ready 09/03/2012 09:00:00
Review inHa 16:00:00

The columns to be displayed can be defined via SysConfig
"Frontend -> Agent -> View -> ITSMChangePIROverview ->
ITSMChange::Frontend::AgentITSMChangePIR# # #ShowColumns":

7 8.12. PIR - XfEfgHE

B & #15

SEPRFFaa R E] =) SEME T 5B YA B HAF0 AT /]
SEPREERAT(E] =) LB LT ALY B HAF0 AT ]
Bx & LB EE
TECIRA = LTEEERANBF
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B A& #15

LEZIE = LEZIENEF

LEERS =) RAREMWBRERS

TERSE & TERSE

TENRSHES a RO FT BRI EIRSIE R
LB = LEHRHR

SIS 8] =) B2 T ERYAY B BAFNAT (&)

AL & LTEHITREARUIR

THXIFFsaATE] = T XUSEHE 22 5B B9 FF 4R B HAF0ET (8]
T AR E] = it T SEME ST AR Y B HAFNET (8]
LR = LB TR

FRi5 R[] & E P HIEERSE H A

ARSS = LB MRS

TIFESHRS AR = LAPIRDECHIARSS A S
TIFE<SRmS = TIFE<SHmS

TFESRE = TERRNIIFESHE
TFESRTES a Eﬂﬁﬂ%ﬁ%lﬁﬁ%%ﬁﬁ
TFE< 1Rt = TIFE< IR

TIriE< kR a Trig<myseay

8.4. iRk

XMMEETRRFHEE XEIENR, RS AR EI AR S IIRERIE A 7ok FHEF,
8.22. LE-&RIR

Overview: Template: All

Filter

All(1) | Change (0) | Workorder (1) | CAB (0) 1-10f1 |
| NAME | TveE | cOMMENT | waLDmY | DELETE | CREATED BY | CREATED

Provision new server Workorder Standard template for provisioning new servers wvalid m jane (Jane Smith) 2012-08-28 11:48:32

The columns to be displayed can be defined via SysConfig
"Frontend -> Agent -> View -> ITSMChangeTemplateOverview ->
ITSMChange::Frontend::AgentITSMTemplateOverview###ShowColumns":

i 8.13. &R

= A& #15

fEoaA =) RIGEERMRS ARHTR
(R ERIE & ERJa 2ok B HAF0AY i)

ERE = RIREYER IR

BIEA = BIERIRAVARS A RS
BT 8] = BIZARR AT HY B HAF A 8]
illes = PR 5% E AR AR DI T

B = RIREIBFF
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B A& #15

EiRRS =) RIREIAEBERIE A FRIR

KA 2 1RHREYZEEY

BN = MR B (B T
MiEBS LR ) . BEEIEANEE
(£ A3 TE 0Bk Im B TERXHUARAR.

After installing the Change Management module, the following template
types are available in the system. These <can be defined Vvia
SysConfig "Frontend -> Agent -> View -> ITSMChangelemplateOverview ->
ITSMChange::Frontend::AgentITSMTemplateOverview## #Filter::TemplateTypes":

7 8.14. 1RiREEY

Bt #15

ITSMEZE LEIRIR
ITSMT{RiE< TFE<SER

CAB EEZWERIRIR

8.5. ¥R
ABEREESEERZFMNTENRTFES , RAAET TANRBRERBEMERT — 1 BRMIERI

g :
8-23- g%‘;gﬁ
Search 3¢}

-~ | Create New |

5
f==
L

Requested
Pending Approval
Rejected
Approved

In Progress =

m| »

Brown Jack (jack) -
Johnson Joe (jog)

Mars Mary (mary)

OTRS Admin (root@localhost)

Smith Jane (jane) M)
Change Title - @
MNormal -
[ Run Search ]
& 8.15. 1Ehk
Bt £
LERS BREERSIER , AIMEAES"*"EHEE,
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B #15

LEIRHE REERANBTER

TR R BTRRESHIREE BT SR

CABHRSZ AR ZE X ICABR IR B A ISR

CABEF BRENXHCABRGINEFBRAAER, EXEW
\)‘\ETJ',aEJJ;:EEY,DJIE\EE@ECAB%FH*%)\{EEEE{JE
Wo

LE#ER TR ERANAREER

LEIEH ELEMNREIEHFEER

TE#E<15ER EIFESHIAPER

TEESHE EIEESREPER

LEMRER REEMTRANER

LEFM REERR/ZMRHIER

LEEA PR LR RRIE R

TERE BREERSHEER

LERIE REERIBIER

LEAIEA RLECIRARR

BIBREEMRS AR REBXNEENRSAGHAFRRER

THEESKRSE BITEESIREER

THEESIRS AR BRRANLERESRS AR

EFiEKBHA BEKRLELAIBNEFEER, o CAREITEY
18 (AN BEA1ZI B HA2 ) sAERTAYE) (WNESE
XX/BAREENTE ) #ITEE,

THXIRYFF 4a Rt (8] R XISChe L B AV A48 H HAFORT (B8 &, B AR
“eytadiE) (SN BHEALZIBHA2 ) AR AT (E] (40
ERIEXK/AREIENEE ) #ITRER,

THXI£E5REY 8] L L E T RILE R HHAFNAT B &R, PTLAR
“exdadiE] (SN BHEALZIBHA2 ) SAEXTAT(E] (40
ERIEXK/BARNEIENEE ) #ITIEER,

SERRFF AR i8] &SIt T B SEPRAY 4R H HAFNRY (B i8R, "TLARR

“aythdie) (WM EHEALIZIBHA2 ) SARYTRYE (30
EREXK/FRCIENEE ) #ITHER.

SEPR4E R AT (8]

TESEMER B SRS R H EARIAY (B I8 R, RIBARK
(oyShdiE] (SNANBEHEA1ZIEHA2 ) SAETAYIE] (40
EREXKX/ERCIENEE ) #1TEER.

BT E] RAEZTERHEAFIE EIEER, 7] AR A (6]
(SNIMBEALZIHEA2 ) SABXTATE) (ANTEREX

K/ERBIZHERE ) #ITIEER,
L) RIENLER BRI EE R, =] BAIRLIT AT E)

(SNBEA1ZIHER2 ) SARXTATE) (ANTEREX
R/IBREIBNEE ) #HITER,

8.6. TELIE

OTRS:ITSMASHRMERMRS AREH— N RRIRE , RERMBIEEMHEEZENTE,
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E 8.24. TE-TFEEIE

Overview: Change Manager: All

Requested 1 | Pending Approval 0 | Approved 0 | In Progress 0 | Pending PIR 1 -3
1-20f2 |
| sTATE | cHANGEZ ¥ CHANGETITLE | CHANGEBULDER | CHANGE MANAGER | WORKORDERS | CHANGESTATE | PRIORMY | PLANNED START | PLANNEDEND |
Migrate OTRS
= 201208203094000021 5 Jane (Jane e 0 Pending PIR 210w
environment to Smith) Smith) g
3.2 bet].]
Enable Cloud jane (Jane jane (Jane
[ ] 201208283894000049 0 Requested 2low
Printing Smith) Smith) q

The displayed column headings can be sorted according the following attributes
in ascending or descending order. The columns to be displayed can be defined
via SysConfig "Frontend -> Agent -> View -> [ITSMChangeManagerOverview ->
ITSMChange::Frontend::AgentITSMChangeManager###ShowColumns"

* 8.16. TFELXIE

Bt ik #15

SEFRFF 4R AT (8] =) SKHESE BT 9a R0 B EAFNRT (8]
SEPREETRAY ] =) LB LT AL kY B HAF0AT ]
Bx =) LB EE

TECIERA = TEEERANRT

LERIE = TEZEBENEF

LERS = AREMPIZERS

TENRSE = TERE

TENRBES = RIFA] BRI BREIRSIE R
LB = LTEHRM

BR8] =) B TR AY B #AF0AET (8]

# =) LTEHITRERRIR

XU FF R E] = T XU SKHE R 5B A9 7T 45 B HAFIAT (8]
T AR E] = Pt 2 5 SEME ST AR Y B HRFNET (8]
LR = RSOl Bl

ER 15 Y (8] =) EFHIEER e H A

ARSS = LB MRS

TriE<% = LTEEXNIIFRESHE

In addition, the Change Manager Overview can filter the displayed
Changes by various attributes as follows. These can be defined Vvia
SysConfig "Frontend -> Agent -> View -> [TSMChangeManagerOverview ->
ITSMChange::Frontend::AgentITSMChangeManager## #Filter::ChangeStates" if desired:

* 8.17. TEZFBTIER

Bt #15

SRR ERRERBEBERNMELE

e BRRERFEMBIMELE

G BUNCZE i1 BRRSH BLHER"IAEEE
SbIEFR ERRERCEF'HRETE
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8.7. BMILE
"HNEEMEERASMERMRSARRZNAEEE (RSARBEMAEELIEAN)
8.25. TE-HMNT

Overview: My Changes: All

Requested 1 | Pending Approval 0 | Approved 0 | InProgress 0 | Pending PR 1 B>
1-20f2 I
STATE | cHanGE# | CHANGE TITLE | CHANGE BULDER | WORKORDERS | CHANGE STATE | PRIORTY PLANNED START ¥ | PLANNED END
Enable Cloud
[ 201208283894000049 Printing Jjane (Jane Smith) v] Reguested 2 low
Migrate OTRS
[ ] 201208283894000021 test environment  jane (Jane Smith) 1] Pending PIR. 2 low

t03.2 bet].]

The display can be sorted by the column headings in ascending
or descending order. The attributes can be defined via SysConfig
"Frontend -> Agent -> View -> ITSMChangeMyChangesOverview  ->
ITSMChange::Frontend::AgentITSMChangeMyChanges# ##ShowColumns ":

i 8.18. HMETE

B A& 3

SEPRFaa AT E] =) SEHE T 5B FF 4Rk B HAF0 AT ]
SEPREETRAY E] =) LB 5epk kY B EAF0RT (8]

Bx & LEHHKENKE

LTEEIEA = TEEEANBF

LEZIE = LERIENEF

LEERS = ABEERNTERS

TERE = TERE

TENRBES = RIZT R RWBERSIEREE
LEIRA = LEHIRHM

SR E] a BT R AY B BAFNAET (8]

AL & LTEHARIRUIR

papdbag Eini = T XUSEHE 22 5B B9 FF 4R B HAFNAT (8]
T XI5 RAT 8] = Pt LS STRY Y B HAFIET (8]
LR = TEMMR TR

FRi5 Y ] & EFPHIEMSEH A

ARSS = LB MRS

TIFE<S® = TERXRNIIFRESHE

In addition, the My Changes Overview can filter the displayed Changes
by various attributes as follows. These can be defined via SysConfig
"Frontend -> Agent -> View -> ITSMChangeMyChangesOverview  ->
ITSMChange::Frontend::AgentITSMChangeMyChanges# # #Filter::ChangeStates":

< 8.19. HMETETIE:E

Bt =3
BiEK ETRREHEBKRMAERE
e BRRSAFEM"WRERE
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=] ¢ E3
BT EH ERRE BLER"IFEEE
RbIEFR ETRREH"IEF'HRERE

8.8. HHVTIFiE<S

EUFOTRST H5|ZE/BiE TR "HUE , ORSEITSMAHFIE RIS ARREHR T - B2HAIN
B, RERDESA M/ TIFRES.

8.26. TE-HITIFIE<S

Overview: My Workorders: All

Created 2 | Accepted 0 | Ready 0 | In Progress 0 =3
1-20f2 |
| STATE | WORKORDER# | WORKORDERTTLE | CHANGETTLE | WORKORDERAGENT | WORKORDER STATE || PLAMMED START _ w| PLANNEDEND |
Provision new Enable Cloud 0812812012 08/29/2012
[ 201208283894000045-1 j J Smith Created
server Printing CABEEDEn., rests 12:20:00 21:29:00
Migrate OTRS
0812812012 08/28/2012
[ ] 201208283894000021-1 Check Chef script test environment  jane (Jane Smith) Created
t0.3.2 bet.] 13:30:00 14:30:00

The displayed information can be sorted by column headings in ascending
or descending order. The attributes used can be defined via SysConfig
"Frontend -> Agent -> View -> [|TSMChangeMyWorkOrdersOverview ->
ITSMChange::Frontend::AgentITSMChangeMyWorkOrders# ##ShowColumns":

% 8.20. HMILIFES

Bt s #15

SRR FF 4R AT (8] & SKHESE BT 9a R0 B BAFNRT (8]
SEPREETRAY ] a L Lt e Ak Y B HAF0 AT /]
E% E\ TE/\?I:D igg

TECIEA & TELBANBTF

LEZIE & LEZIBHNEF

LTERS =) RREMNTERS

TERE =) TERS

TENRSES & RUIFAT ERIBEIRSIERE
LE el = LTEHRHM

BT 8] a Bl T ERTAY A BAFNET (A]

# =) LETHARIRIER

T XU FF 2R (8] = T XU SEHE R 5B A9 7 45 B HAFIAT (8]
T LA TRAYE] = it T SRR B HAF0RT (8]
AR & LEMRERA

RS ] =) %F%“%iﬁﬁ%

ARSS = FMEIARSS

TIFESIRS AR = 5 PIR"EEE"JHEQAE
TIFE<SHmS = TIFESHmS

THEESRE = TERXRNIIFRESHE
TFESHBES & %qu§TMI¢E ARTSHR
TIFiE<ira = TIFIE<S MR
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In addition, the My Work Orders Overview can filter the displayed
Work Orders by various attributes as follows. These can be defined via
SysConfig "Frontend -> Agent -> View -> ITSMChangeMyWorkOrdersOverview ->
ITSMChange::Frontend::AgentITSMChangeMyWorkOrders# # #Filter::WorkOrderStates":

*® 8.21. HMTIFIESTIRER

Bt #15

[=yciFeS BRRENECIR'NMBEIFRES
BEX BERRSHEEZNMBIFES
HEETA BRARSH EESTRTMELIFES
LbIEF BRRERECEFHMBEIERES

Ve o A Y
9. TEEBFRIT
OTRS:: ITSMIZH TEMIRRFK I (G XEBIEMNEBETEEIE, FTERRETESAT AN ERIRETRE
Ry 28141,

9.1. —MHEERANTENE

XAMRRAVFE X —PMENES[EER (MEFIEXKARITE ) sEIIATEER (M BEI1EIBEI209%5
E). Ubsh, BRI EXBEMBRNIEEIRTS,

IR A TR VS TED ( PDF) ”,
9.2. BEHEXHNIMTENE

EAMRRAVFE X —PMENESE]ER (MEFRIEXKARIZE ) sEISATEER (M BEI1ZIBHI209%5
EF). Ubsh, BRI E X BEMBRNEERTS,

IR ST DR CSV' S TED (PDF) 7,
9.3. EENTENE

XAMRRAVFE X —PMENESEER (MEFRIEXKARITE ) sEXTATEER (M BEI1ZEIBEI209%
B IS, BRTE XBEMBRRITEIRS.

R H RN TLAZ CSV"sL"$TEN (PDF) ",

9.4. HEIMETENE

XAMRRAVFE X —PMENESEER (MEFRIEXKARITE ) sEIIATEER (MM BEI1ZIBEI209%5
B IS, BRTUEXBEMBRRWTEIRS.

R H AR TBAZ CSV"s,"$TEN (PDF) ",

9.5. TEMAERILLS!

XAMRRAVFE X —PMENESEER (MERIEXKARITE ) sEISATEER (MM BEI1ZIBEI209%
B IS, BRTUEXBEMBRRWTEIRE.
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R 5 AT CSVSEITED ( PDF) 7,
9.6. BNMBERKAMNZEIFN

EAMRRAVFE X —MEWASEER (MEREXKANEE ) sifITRTEER (MM BHALEIRHA2R9E
B o, BRIUEXBEMBRIUEEFRA,

R HA8 0T BAR“CSV BL "4 TEN (PDF) ",
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5

SR =pEd

BHER , BAPTRIEERBOTRS ITSMR ARSI AR EE, B2 , JMEE. BHRMNEFERE
BIERRRAE.0,

E2AOF , TUREMERARBDSL ( RERHE ) RIERN S 5T,
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£ 10 E fRSEHIEE

OTRS 2.1%LqhR TRERAITELR , AFEIWEBRESIZ/LFAEETIEMRR  MRSEAS
H—#F, b5 , EAOTRSIMAMEFEUZFITNGE , RABIEREBREIEENA,. EN/HNEELEMN
MERFHTER, EFLKIRER , HIERTERSIFREN | XEWRE L—OTRSIRALEMIIAIT

RIRITBEMEE(ER, =5O0TRS:ITSMEASERR , BERERRSEHNEREREBETUEMSITARS
B R AMTINLE T,

— MRRE RIS

10.1. RS AGR-T 8-t

Overview: Stats

Actions List
E Add STAT#A. TITLE OBJECT DESCRIPTION
X X X X List of all tickets closed last month.
List oftickets closed last manth Ticketlist
Import Order by ag[.]
X X Total number of new tickets per
Mew Tickets TicketAccumulation X
day and gueue whic[...]
List of open tickets, sorted by time left until SERPHTE List of open tickets, sorted by time
icketlis
response deadline expires left until ref..]
List oftickets closed, sorted by response X X List oftickets closed last month,
i Ticketlist
time. sorted by respol..]
) ) ) ) List of all tickets created last
List oftickets created last month Ticketlist
month. Order by a[..]
List oftickets closed last month
List of the most time-consuming tickets Ticketlist )
which required t...]
List of open tickets, sorted by time left until T List of open tickets, sorted by time
escalation deadline expires left until es[._]
X X o X X List oftickets closed last month,
List oftickets closed, sorted by solution time Ticketlist
sorted by solutf.]
X X X X X Current state of all tickets in the
Overview about all tickets in the system TicketAccumulation X
system without]..]
List of open tickets, sorted by time left until T List of open tickets, sorted by time
icketlis
solution deadline expires left until sof...]
) ) Monthly overview, which reports
Changes of status in a monthly overview StateAction
status changes per|..]
Total number of all tickets ever created per ) ) Total number of all tickets ever
i L TicketAccumulation X
Ticket-Type and Priority. created per Ticke]...]

SHRTIREXML
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10.2. RBAGR-FHIT-FH-BA

View: Stat# 10002

10002
New Tickets

. TicketAccumulation

in: Total number of new tickets per day and gueue which have been created

Actions Stat Details
| Go to overview | Stat#:
Title:
| Eait |
| Detete |
Format
| Export config ‘
Sum columns:
Cache:
Hint alidity:
With the input and select fields you can BEREUEAE
influence the format and contents of the
statistic. Exactly what fields and formats you
can influence is defined by the statistic
administrator.
X-axis
Create Time
Value Series
Queue:

ETHEECIE — A IRRER -
10.3. RTR-FiT-18EIR

Edit: Stat# 10002

Step 1

Step 2

Actions General Specifications (1/4)

Go to overview

=+ Description:

* Dynamic-Object:
% Permissions:

= Resultformat:

during the last month.

Opening Mew_Tickets_2012-08-30_10-05.xml

=

You have chosen to cpen
=] New_Tickets_2012-08-20_10-05.5ml

which is a2 XML Document (692 bytes)
from: http://vel298.vo.otrs.com

What should Firefox do with this file?

() Openwith | Internet Explorer (default)

ave File

7] Do this automatically for files like this frem now en.

% Title:

Misc
Postmaster
Senvice Desk

Step 3 Step 4

New Tickets

Total number of new tickets per
day and queue which have been
created during the last month.

TicketAccumulation

-

itsm-change-builder
itsm-change-manager
itsm-configitem
itsm-senice
stats

You can select one or more groups to define access for different agents.
Csv -

graph-area
graph-bars
graph-hbars

EEHT—PDFLERZS , APDFSRSHEREMMI TR, HHHFIERERITENNE.,
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10.4. PDF-3X#5-#1E

% OTRS iisins” Stat#£10002
New Tickets 2012-07-01 00:00:00-2012-07-31 23:59:59 printed by Jane Smith (jane@otrs.com) 08/30/2012 10:21:08
Misc o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o
Service Desk 0 o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o
Sum a o o o o o a o o o o a o o o o a o o o o a o o o o o o o o o o

10.5. PDF-30#4-1 55

>§< OTRS Raizenven™ Stat#10009
Overview about all tickets in the system printed by Jane Smith {jane@otrs.com) 08/30/2012 10:24:26
Quewe  chmsdsuecesmhl  closedunsuceessful  closed with workaround merged  new  open  pendingaute closer pendingauto close: pending reminder  removed  Sum
Mizc o o o o o o o o o o o
Pegmemer 0o e e & 8= e e e
Service Desk 1 0 o o o 4 o o o o 5
Sem 0o e e e 0@ e e e e
Sum 1 0 o o 42 4 o o o o a7

— MNEFALR T RS
E 10.6. T5-Efs-t#]5

Overview about all tickets in the system

25
20+
15
10+
5L
0 L l L L L L
S5 = o o = = + 1 = =]
B B 5 g o 2 0 2 2 g
0 o 2 c o @ =) c 2
il @ 2 @ ch o E £
2 o R E o 2 g 2
3 3 =3 =
n ] o 5 % o
[ = [
= C
o = = o £
o o =l =y [t o
o @ = = = S
o (5] ; s [ o
s - 5 g
=] x o o
(=]
o
Queue
I Misc I Postmaster Wl Service Desk [@Spam

60



$£ 11 Z OTRS:ITSMALZEIEX

FAEERRTLRGNERNTRIED, FARBOMEES BT BREN/HEN
ATNESI R AR E A RIS N RS,

AGEEXBIRIS AARASHEN"RASIEH®EALD., AEERNAFEERASERNREREA
KRNI M, BTN RRE | &eTLAEA "root@localhost"E HORRSAAEIERE REIR
%  BHEELENRRE—T LN,
« #EOTRS::ITSM 1.08
s [ BAREXR]
[ BRE -®m - %R ]
o [BECEIN ]
« FEOTRS::ITSM 1.18
s [BAEH ]
« FEOTRS::ITSM 2.08
o [ BH] (ITSMTLEERE) ]
o [ %5 - #2200 - LER ]
o [IRZEH ]
« 7EOTRS::ITSM 2.25
o [ER]
s [IRE]
s [BRS ]
« [SLA]
« FEOTRS::ITSM 2.3F

s [R5%ER ]
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11.1. RFEEKX

gl g2 g2 i-: A: in as Jane Smith m
DASHBOARD | TICKETS | SERVICES | CMDB | CHANGES | STATISTICS | CUSTOMERS Q,
Admin
Agent Management Customer Management Email Settings

Queue Settings Ticket Settings

1. BAHAEX

IENEMIER— , BABRATOTRS:ITSMAREAWITSMAXEE

11.2. AEEE-EBAER

a2 a2 g2 + 3 Y 2 You are logged in as Jane Smith [E]

DASHBOARD | TICKETS | SERVICES [ CMDB | CHANGES | STATISTICS  CUSTOMERS Q,

General Catalog Management

Actions List
CATALOG CLASS

E3 Add Catalog tem

E3 Add Catalog Class

Flangmis T hiFERATRIS I ARE ¢
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2’ &’ a’

DASHBOARD TICKETS SERVICES CMDB CHANGES STATISTICS CUSTOMERS

General Catalog Management

Actions List
ITSM:Configitem:Computer: Type - ITSM::CONFIGITEM::COMPUTER: TYPE VALID
— valid
Add Cataloeg It
&3 Add Catalog tem valid
3 Add Catalog O1 velid
e valid
valid
Go to overview
valid

2. EEERCEINZE

OTRS:ITSMEARESNEEEINMERRRFAIBITHXTE :
o [iHEWMN]

1§2E1’Fj31+%mﬂ’]ﬁﬁﬁ@3§1ﬁ PN REPCHEEICHAEMMEEELE. FJEEEMIFIERIREN
KM, BEEHBFNECIENM BB

- [5EfF]
5E*2|J > At BRI REAAA |, PTEERSEREIMN TIR RO HIFEZIFTENYL, USBAITFESE , BURT
ZRAIHIRIE A,
o [M£8]
BEEMLE (LAN, WLAN, WANES) |, GAIPHbiL,
o [#HF]
AT B BYAR = AN AT
« [fIE]

FRBERME , SNEHF. TIFE. TR

INFXSASEF R BERIF IR EHITING |, PILLELOTRS:ITSMASGEIRX K@M B R i RIE
BHE, QBT —MMEEDER , W EERENEBALIE X,

B 11.4. ZAEE-ERAER

g2 g2 92 -i- “' You are logged in as Jane Smith m

DASHBOARD TICKETS SERVICES CMDB CHANGES STATISTICS CUSTOMERS ADMIN Q

General Catalog Management

Actions List
ITSM:Configitem:Class - ITSM:CONFIGITEM::CLASS VALID
— valid

Add Catalog It

= == valid
— valid
E3 Add Catalog Class vl
valid

Go to overview

63



OTRS

Real Services

5 A=
E_I:I

CMDBEIEREFN XXM ETIRYIRTT , BAFIRIRMGIVES. BMNMNERETR @ FEEX
OTRS:ITSMARERIEREF/NECEMR 2/l , SEEFELAENEITERMIRNE DI
%, CMDBiZiHEENIMNERRVASBIANITILSEE E R E L WIEAZ B MER,

Multiple input field types can be used when defining a class. These input field types are
used to generate the edit form for creating new or editing already existing configuration
items.

R
=0

Since version 6.0.18 the configuration item class definitions have to be written in
YAML format.

The following block is an example of a form field called Operating System.

- Key: OperatingSystem
Name: Operating System
Input:

Type: Text
Size: 50
MaxLength: 100

The following settings are available when adding or editing this resource. The fields
marked with an asterisk are mandatory.

Key *

Must be unigue and only accept alphabetic and numeric characters. If this is changed,
data will not be readable from old definitions.

Name *

The label of the field in the form. Any type of characters can be entered to this field
including uppercase letters and spaces.

=z
=
It is recommended to always use English words for names.

Names can be translated into other languages with custom translation files. See the
Custom Translation File chapter in the developer manual.

Searchable
Defines whether the field is searchable or not. Possible values are 0 or 1.
Input *

Initiates the definition of the input field. An input field can contain the following
attributes:

Type *

Defines the type of the element. Must be placed indented as a logical block.
Possible values are:
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» Text: A single text field.

» TextArea: A text field with multiple rows.

* GeneralCatalog: A drop-down list for select a general catalog class. The general
catalog class must be defined before use it as input type. The items of the
general catalog class will be the options of the drop-down list.

* CustomerCompany: A drop-down list for select a customer from the database
back end.

* Customer: A drop-down list for select a customer user from the database back
end. The field can be used with wildcards (*).

» Date: A field for select a date.

* DateTime: A field for select date and time.

» Integer: A drop-down list with integer numbers.
Required

Defines whether the field is mandatory or not. Possible values are 0 or 1.
Size

Defines the size of the text field. The value must be a positive integer.
MaxLength

Defines the maximum amount of characters that can be entered in the text field.
The value must be a positive integer.

RegEx
A regular expression to restrict the possible values of the text field.
RegExErrorMessage

The displayed error message if the input does not match to definition given in the
regular expression.

Class

The name of the class to be used for the drop-down list. Required for type
GeneralCatalog.

Translation

Defines whether the items of a general catalog have to be translated. Possible
values are: 0 or 1.

YearPeriodPast

Defines how many years in the past are available for selection from the present
year in a date or date/time field. The value must be a positive integer.

YearPeriodFuture

Defines how many years in the future are available for selection from the present
year in a date or date/time field. The value must be a positive integer.
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ValueMin
Defines the minimum value for an integer field.
ValueMax
Defines the maximum value for an integer field.
ValueDefault
Defines the default value for an integer field.
CountMin

Defines at least how many of the current input types are available. The value must
be a positive integer.

CountMax

Defines at most how many of the current input types are available. The value must
be a positive integer.

CountDefault

Defines how many field should be displayed by default. The value must be a positive
integer.

Sub

Defines a sub-element in the input field. The sub-element can contain its own input
fields. It is useful if you have certain properties under a main property.

SuppressVersionAdd

This can be used to suppress creating a new version of a configuration item, when an
attribute has changed. Possible values are UpdatelLastVersion and Ignore.

* UpdatelLastVersion: If this value is set and there is no other updated attribute, the
attribute is updated in the current version without creating a new version.

» Ignore: If this value is set and there is no other updated attribute, nothing will be
done, and no new version is created.

The following class definition is an example for all possible options.

- Key: OperatingSystem
Name: Operating System
Searchable: 1
Input:
Type: Text
Required: 1
Size: 50
MaxLength: 100
RegEx: Linux|MacOS|Windows|Other
RegExErrorMessage: The operating system is unknown.
CountMin: 0O
CountMax: 5
CountDefault: 1

- Key: Description
Name: Description
Searchable: 0
Input:

Type: TextArea
Required: 0
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CountMin: 0
CountMax: 1
CountDefault: 0

Key: Type
Name: Type
Searchable: 1
Input:
Type: GeneralCatalog

Class: ITSM::ConfigItem::Software::Type

Required: 1
Translation: 1

- Key: CustomerCompany
Name: Customer Company
Searchable: 1
Input:

Type: CustomerCompany

- Key: Owner
Name: Owner
Searchable: 1
Input:
Type: Customer

- Key: LicenseKey
Name: License Key
Searchable: 1
Input:

Type: Text
Size: 50
MaxLength: 50
Required: 1
CountMin: 0
CountMax: 100
CountDefault: 0O
Sub:
- Key: Quantity
Name: Quantity

Input:
Type: Integer
ValueMin: 1

ValueMax: 1000
ValueDefault: 1

Required: 1
CountMin: 0
CountMax: 1

CountDefault: 0

- Key: ExpirationDate
Name: Expiration Date

Input:
Type: Date
Required: 1

YearPeriodPast: 20
YearPeriodFuture: 10
CountMin: 0
CountMax: 1
CountDefault: 0

- Key: LastUsed
Name: Last Used
Input:
Type: DateTime
Required: 1
CountMin: 0O
CountMax: 1
CountDefault: 0O
SuppressVersionAdd: UpdatelLastVersion

A ATE B B B OB T S 3 I TSR TE S SRAE SAMET B
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11.5. RAEEE-EENEIE-1EX

' = + ] F 3 = You are logged in as Jane Smith m

DASHBOARD | TICKETS | SERVICES |CMDB | CHANGES | STATISTICS | CUSTOMERS Q

Config ltem Management

Actions Change
Computer ~ Computer
Change class definition [ .
Key => "Wendor',
Go to overview Name => '"Vendor',
- Searchable =» 1,
Input =»> |
Type => '"Text',
Size =» 50,
Maxlength => 50,
b
b
{
Key => "Model',
Name => "Model',
Searchable => 1,
Input => {
Type => "Text’,
Jize =» 50,
Maxlength =» 50,
I
T
{
Key => 'Description',
Name => 'Description’,
Searchable = 1,
Input => |
Iype =» '"Textldrea’,
b
b
{
Key => "Type',
o= =
= H

ATHHROTRSITSMERRAEN —HE , ARAEEXCIZNEE AR —RANERE
k%, WMRABRNBEXLES , R RET BT AL T 0 IEES R8BI =T,

3. FEENE R AEIE
FrEREDEMNMAEIEREMEIRAZPN, ORS:ITSM{ERAREMMARLGIZEE BN,
11.6. AAEE-LEMEIER

a2 g2 g2 + 3 2 2 ou are lpgged in as Jane Smith El

DASHBOARD | TICKETS | SERVICES | CMDB | CHANGES STATISTICS | CUSTOMERS o

Config ltem Management

Actions List
Computer + CONFIG ITEM CLASS VERSION | CREATED BY CREATED
ct d definiti 1 root@localhost (Admin 0812712012
= OTRS) 10:50:47

Go to overview

4. HETRIRE

EXSFITILAEPEE IR |, #IFE 0] AR INRE RS ERANTIEEXF, hERR—FXFE
3l , ORS:ITSMEIABE & T RIS BTN T B X F",
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11.7. RAEE-RKSEE

.z_i_z lz

DASHBOARD TICKETS SERVICES CMDB CHANGES STATISTICS CUSTOMERS

State Management

Actions List
ﬁ Add state NAME TYPE COMMENT VALIDITY CHANGED CREATED
Ticketis closed 0812312012 0812312012
closed valid
sucl...] 14:26 14:26
Hint Ticketis closed 082312012 08232012
closed valid
unsl...] 14:26 14:26
e the states in 08272012 0gi2vizo2
closed ticket is closed wit...] valid
10:48 10:49
X 08/2312012 08232012
merged State for merged tic]..] valid
14:26 14:26
Mew ticket created 08/23i2012 08232012
new valid
bi..] 14:26 14:26
. 0812312012 0812312012
open Open tickets. valid
14:26 14:26
) o ) 0812312012 0812312012
pending auto Ticketis pending fo[..]  valid
14:26 14:26
08/2312012 08232012
pending aute Ticketis pending fo[..]  wvalid
14:26 14:26
pending o _ 08/23/2012 08/23/2012
_ Ticketis pending fo[.]  wvalid
reminder 14:26 14:26
Customer removed 08/23/2012 08/23/2012
removed . valid
tic[..] 14:26 14:26

FEOTRS::ITSMAERET LAELL I B B T B ARBTARIM—NRVIRS, ERANEZHED : RSB
Fr“state-name"FIERIZE A “state-type”, FTHEEKIAT] FAIRSFISEEL N EEIFTR,

REBME] B RIERE, ERAEEFRE R RER ] ANRIFRSSUEERBIRSEER
(g newF B IR SFEEIENECE X 4 Kernel/Config. pmEiE EIFZEC E R E1E Y,

[...]

# PostmasterDefaultState

# (The default state of new tickets.) [default: new]
$Self->{PostmasterDefaultState} = 'new';

# CustomerDefaultState

# (default state of new customer tickets)
$Self->{CustomerDefaultState} = 'new';
[...]

BRI BRIRT | FEEREXfKernel/Config. pmEEIFECE R I,

[...]
# default phone new state
$Self->{'Ticket::Frontend: :PhoneNextState'} = 'open';

# PostmasterFollowUpState
# (The state if a ticket got a follow up.) [default: open]

$Self->{PostmasterFollowUpState} = 'open';

[...]
B A

AT HROTRSITSMERNEEN —Ht , ARAEEXIBNEE TR RNV ERE
bR, RMMBARFEILRER |, FHENMEYTIRS 5'6IﬁM”ﬁx‘ﬁl"%ﬁi”?ﬁx‘ﬁl"ﬂ”l Y TTRR "B =],
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5. &5 - M - AL

OTRS:ITSMEEHM TSN TEMRERS :

- [RRE]
TRF/EFPHIRSHESREE

- [#mm]
X ARS RN A /2% P RIS

s [L%R ]
OTRS:ITSMAL LR ZNZZEMFMITEMLER

OTRS:ITSMT BEEH2H T EEAEMERER , A EIIMEISER TMELR (ZRLERHF , &
MR ERERE ) .

11.8. RFEEE-LERHE

a2 g2 g2 ‘t’ na Y in as Janz Smith [F]

DASHBOARD | TICKETS | SERVICES | CMDB | CHANGES | STATISTICS | CUSTOMERS o

Criticality <-» Impact <-> Priority

Note Priority allocation
IMPACT \ CRITICALITY 1 VERY LOW 2 LOwW 3 NORMAL 4 HIGH 5 VERY HIGH
1very low Tverylov Tverylow v 2 low - 2 low - 3normal «
2low Twverylov = 2 low - 2 low - 3normal 4high =
3normal 2 low - 2 low - 3normal - 4high - 4high -
4 high 2 low - 3normal « 4high - 4high - Svery hi¢ v
5very high Inormal - 4high - 4 high - 5wvery hi¢ ~ Svery hi¢ »

_ Submit |

RARS, EANERMINETRAEIEREAYERB R PR MEN
11.9. A EEE-BAEREE-MER

a2 g2 42 i’“ ‘7_ in as Jane Smith m

DASHBOARD | TICKETS | SERVICES | CMDB | CHANGES | STATISTICS | CUSTOMERS Q,

General Catalog Management

Actions List
ITSM-Core: Crilicaliry - TSM::CORE:CRIMICALTY WALID
— valid
&3 Add Catalog ltem Vi
3 Add Catalog CI yaid
[l B AR valid
wvalid

Go to overview

6. HET HEL

OTRS:ITSMAAIT BIFBEARMERLTH , ISMHERN TR ERETIMERR L , {RLLRHNIE
SRERRNOVE, TUEEFEEERERE. EHnRMERMLER.
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11.10. RAEEE-LEREE

g2 92 92 -g-: l: Yo as Jane Smith E]

DASHBOARD TICKETS SERVICES CMDB CHANGES STATISTICS CUSTOMERS

Priority Management

Actions List
E3 Add priority NAME VALIDITY CHANGED CREATED
- valid 08/23/2012 14:26 0812312012 14:26
valid 0B/23/2012 14:26 08/23/2012 14:26
valid 0BI23/2012 14:26 08/23/2012 14:26
valid 0BI23/2012 14:26 0B/22/2012 14:26
valid 0B/23/2012 14:26 08/23/2012 14:26

A AfEOTRSEEFMPHKEIE S HIFHIER,

Bk A
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“ID"BMHREOTRS:ITSMILERBIARZIGF , 1EREN , 5 (HES ) AREK, RLERSZ
MRAREVERF SR SRIL A Se R Y IERRIR .

2 A=
5

A THRIROTRSITSMERRAEN —HE , ARAEEXCIZNE SR —RANERE
k%, WMRIFBRNBEILES | FERFRETN BT T 0 IEES 2L BN =],
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EFRANRRNOTRSHEINIBWAR , FIERFRETEE, ERAAEETHENRALET ,
‘g EAEcalendarl Z 889558 , BAMRS AT BUEREI991,

12.1. RREEE-RFEE

22222%4°a?

DASHBOARD | TICKETS | SERVICES |CMDB | CHANGES | STATISTICS | CUSTOMERS Q

SysConfig
Actions Result
Search | SUBGROUP ELEMENTS GROUP
g in 2269 settings 28 Framewark
32 Framework
Framewaork (432) A 3] Framewaork
Navigate by selecting config groups 4 Framewark
3 Framework
¥ Export settings 12 Framework
7 Framewaork
X Import settings 3 Framewark
- 1 Framework
2 Framewaork
9 Framework
16 Framework
4 Framewaork
il Framework
17 Framework
10 Framework
5 Framewaork
5 Framewaork
5 Framework
5 Framework
5 Framewaork
5 Framework
5 Framework

OTRS::ITSMAfER“TimeWorkingHours T{ERY[8]"RE X FTiBHY RS KAIE Q" , MEBERRIELE
PREENRS AN ESEE, WMRFE , 0T AR/ IX LR 8] 5E E A RIER G AR S
A,
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12.2. RAEEIE-REECE-T{FAT(E)

DASHBOARD | TICKETS | SERVICES |CMDB  CHANGES | STATISTICS | CUSTOMERS o,

SysConfig

Actions Edit Config Settings in Framework -> Core::Time::Calendar1

Go to overview
= TimeZone::CalendariName

5td Business Hours

Defines the name of the
indicated calendar.

TimeZone::Calendart +0 =~

Defines the time zone ofthe
indicated calendar, which can
be assigned later to a specific
queue.

TimeVacationDays::Calendar1
Month — Day — Text

1 1 Mew Year's Day (9

5 1 International Work (=)

12 24 Christmas Eve

12 | 25 | FirstChristmas D (@
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« NAGIOS

* SOAP

* REST

* LDAP

* E-mail (POP3, IMAP, SMTP)

« CSVEARH
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